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IMPORTANT SAFETY INSTRUCTIONS
WARNING FOR YOUR PROTECTION
READ THE FOLLOWING:
KEEP THESE INSTRUCTIONS
The symbols shown above are internationally accepted symbols that
warn of potential hazards with electrical products. The lightning flash
with arrowpoint in an equilateral triangle means that there are dangerous voltages present within the unit. The exclamation point in an
equilateral triangle indicates that it is necessary for the user to refer to
the owner’s manual.
These symbols warn that there are no user serviceable parts inside
the unit. Do not open the unit. Do not attempt to service the unit
yourself. Refer all servicing to qualified personnel. Opening the chassis
for any reason will void the manufacturer’s warranty. Do not get the
unit wet. If liquid is spilled on the unit, shut it off immediately and
take it to a dealer for service. Disconnect the unit during storms to
prevent damage.

Safety InStructIonS
NOTICE FOR CUSTOMERS IF YOUR UNIT IS EqUIPPED WITH A POWER CORD.
WARNING: THIS APPLIANCE SHALL BE CONNECTED TO A MAINS SOCKET
OUTLET WITH A PROTECTIVE EARTHING CONNECTION.
The cores in the mains lead are coloured in accordance with the following code:
GREEN and YELLOW - Earth

BLUE - Neutral

BROWN - Live

As colours of the cores in the mains lead of this appliance may not correspond with the coloured markings identifying the terminals in your plug,
proceed as follows:
• The core which is coloured green and yellow must be connected to the
terminal in the plug marked with the letter E, or with the earth symbol,
or coloured green, or green and yellow.
• The core which is coloured blue must be connected to the terminal
marked N or coloured black.
• The core which is coloured brown must be connected to the terminal
marked L or coloured red.
This equipment may require the use of a different line cord, attachment
plug, or both, depending on the available power source at installation.
If the attachment plug needs to be changed, refer servicing to qualified
service personnel who should refer to the table below. The green/yellow
wire shall be connected directly to the units chassis.
CONDUCTOR

HEED ALL WARNINGS
FOLLOW ALL INSTRUCTIONS
THE APPARATUS SHALL NOT bE ExPOSED
TO DRIPPING OR SPLASHING LIqUID AND
NO ObjECT FILLED WITHI LIqUID, SUCH AS
vASES, SHALL bE PLACED ON THE APPARATUS.
CLEAN ONLY WITH A DRY CLOTH.
DO NOT bLOCK ANY OF THE vENTILATION
OPENINGS. INSTALL IN ACCORDANCE WITH
THE MANUFACTURER’S INSTRUCTIONS.
DO NOT INSTALL NEAR ANY HEAT SOURCES SUCH AS RADIATORS, HEAT REGISTERS,
STOvES, OR OTHER APPARATUS (INCLUDING AMPLIFIERS) THAT PRODUCE HEAT.
ONLY USE ATTACHMENTS/ACCESSORIES
SPECIFIED bY THE MANUFACTURER.
UNPLUG THIS APPARATUS DURING LIGHTNING STORMS OR WHEN UNUSED FOR
LONG PERIODS OF TIME.
Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug
has two blades with one wider than the other. A
grounding type plug has two blades and a third
grounding prong. The wide blade or third prong
are provided for your safety. If the provided plug
does not fit your outlet, consult an electrician for
replacement of the obsolete outlet.
Protect the power cord from being walked on
or pinched particularly at plugs, convenience
receptacles, and the point where they exit from
the apparatus.
Use only with the cart stand, tripod bracket, or
table specified by the manufacture, or sold with
the apparatus. When a cart is used, use caution
when moving the cart/apparatus combination to
avoid injury from tip-over.

WIRE COLOR
Normal
Alt

L

LIVE

BROWN

N

NEUTRAL

BLUE

BLACK
WHITE

E

EARTH GND

GREEN/YEL

GREEN

WARNING: If the ground is defeated, certain fault conditions in the unit
or in the system to which it is connected can result in full line voltage
between chassis and earth ground. Severe injury or death can then result if
the chassis and earth ground are touched simultaneously.

Refer all servicing to to qualified service personnel. Servicing is required when the apparatus has
been damaged in any way, such as power-supply
cord or plug is damaged, liquid has been spilled
or objects have fallen into the apparatus, the
apparatus has been exposed to rain or moisture,
does not operate normally, or has been dropped.
POWER ON/OFF SWITCH: The Power switch
used in this piece of equipment DOES NOT
break the connection from the mains.

U.K. MAINS PLUG WARNING

A molded mains plug that has been cut off from the cord us
unsafe. Discard the mains plug at a suitable disposal facility.
NEVER UNDER ANY CIRCUMSTANCES SHOULD YOU INSERT
A DAMAGED OR CUT MAINS PLUG INTO A 13 AMP POWER
SOCKET. Do not use the mains plug without the fuse cover
in place. Replacement fuse covers can be obtained from your
local retailer. Replacement fuses are 13 amps and MUST be
ASTA approved to BS1362.

MAINS DISCONNECT: The plug shall remain
readily operable. For rack-mount or installation
where plug is not accessible, an all-pole mains
switch with a contact separation of at least 3
mm in each pole shall be incorporated into the
electrical installation of the rack or building.
FOR UNITS EqUIPPED WITH ExTERNALLY
ACCESSIbLE FUSE RECEPTACLE: Replace fuse
with same type and rating only.
MULTIPLE-INPUT vOLTAGE: This equipment
may require the use of a different line cord,
attachment plug, or both, depending on the available power source at installation. Connect this
equipment only to the power source indicated
on the equipment rear panel. To reduce the risk
of fire or electric shock, refer servicing to qualified service personnel or equivalent.
If connected to 240v supply, a suitable CSA/UL
certified power cord shall be used for this supply.

IMPORTANT SAFETY INSTRUCTIONS
DecLaratIon of conforMIty
Manufacturer’s Name:
Manufacturer’s Address:

Lexicon Professional
8760 S. Sandy Parkway
Sandy, Utah 84070, USA

declares that the product:
Product name:

Lexicon IO FW810S
Note: Product name may be suffixed by the EU.

Product option:

None

conforms to the following Product Specifications:
Safety:

IEC 60065 -01+Amd 1

EMC:

EN 55022:2006
EN 55024:1998
FCC Part 15

Supplementary Information:
The product herewith complies with the requirements of the:
Low Voltage Directive 2006/95/EC
EMC Directive 2004/108/EC.
RoHS Directive 2002/95/EC
WEEE Directive 2002/96/EC
With regard to Directive 2005/32/EC and EC Regulation 1275/2008 of 17 December 2008, this product
is designed, produced, and classified as Professional Audio Equipment and thus is exempt from this Directive.
Roger Johnsen
Director, Engineering
Signal Processing
8760 S. Sandy Parkway
Sandy, Utah 84070, USA
Date: February 23, 2011
European Contact: Your local Lexicon Sales and Service Office or
Harman Signal Processing
8760 South Sandy Parkway
Sandy, Utah
84070 USA
Ph: (801) 566-8800
Fax: (801) 568-7583

eLectroMaGnetIc
coMPatIBILIty

This device complies with part 15 of the FCC Rules and the Product Specifications noted on the Declaration
of Conformity. Operation is subject to the following two conditions:
• this device may not cause harmful
interference, and
• this device must accept any interference received, including interference that may cause undesired operation.
Operation of this unit within significant
electromagnetic fields should be avoided.
• use only shielded interconnecting cables.
If you want to dispose this product, do not mix it with general household waste. There is a
separate collection system for used electronic products in accordance with legislation that
requires proper treatment, recovery and recycling.
Private household in the 25 member states of the EU, in Switzerland and Norway may return their used
electronic products free of charge to designated collection facilities or to a retailer (if you purchase a similar
new one).
For Countries not mentioned above, please contact your local authorities for a correct method of disposal.
By doing so you will ensure that your disposed product undergoes the necessary treatment, recovery and
recycling and thus prevent potential negative effects on the environment and human health.

Service Info

If you require technical support, contact Lexicon® Professional Customer Service.
Be prepared to accurately describe the problem. Know the serial number of your unit,
found on a sticker attached to the bottom of the IO FW810S. If you have not already
taken the time to fill out your warranty registration card and send it in, please do so
now.
Before you return a product to the factory for service, we recommend you refer to
the manual. Make sure you have correctly followed installation steps and operation
procedures. If you are still unable to solve a problem, contact our Customer Service
Department at (801) 568-7660 for consultation. If you need to return a product
to the factory for service, you MUST contact Customer Service to obtain a Return
Authorization Number. No returned products will be accepted at the factory without a
Return Authorization Number. Please refer to the Warranty information on the following page, which extends to the first end-user. After expiration of the warranty, a reasonable charge will be made for parts, labor, and packing if you choose to use the factory
service facility. In all cases, you are responsible for transportation charges to the factory.
Lexicon Professional will pay return shipping if the unit is still under warranty.
Use the original packing material if it is available. Mark the package with the name
of the shipper and with these words in red: DELICATE INSTRUMENT, FRAGILE!
Insure the package properly. Ship prepaid, not collect. Do not ship parcel post.

Warranty

This warranty is valid only for the original purchaser and only in the United States.
1. The warranty registration card that accompanies this product must be mailed (or
online regisration must be completed at www.lexiconpro.com) within 30 days after
purchase date to validate this warranty. Proof-of-purchase is considered to be the
burden of the consumer.
2. Lexicon Professional warrants this product, when bought and used solely within
the U.S., to be free from defects in materials and workmanship under normal use
and service.
3. Lexicon Professional’s liability under this warranty is limited to repairing or,
at our discretion, replacing defective materials that show evidence of defect,
provided the product is returned to Lexicon Professional WITH RETURN
AUTHORIZATION from the factory, where all parts and labor will be covered
up to a period of 1 year. A Return Authorization number must be obtained from
Lexicon Professional by telephone. The company shall not be liable for any consequential damage as a result of the product’s use in any circuit or assembly.
4. Lexicon Professional reserves the right to make changes in design or make additions to or improvements upon this product without incurring any obligation to
install the same additions or improvements on products previously manufactured.
5. The foregoing is in lieu of all other warranties, expressed or implied, and Lexicon
Professional neither assumes nor authorizes any person to assume on its behalf any
obligation or liability in connection with the sale of this product. In no event shall
Lexicon Professional or its dealers be liable for special or consequential damages or
from any delay in the performance of this warranty due to causes beyond its control.

table of contents
INtRodUctIoN ................................................................... 1
Features ..........................................................................................................1
Unpacking the IO FW810S ...........................................................................2
The following items are included: .................................................................... 2
System Requirements......................................................................................2
FRoNt PANeL...................................................................... 3
ReAR PANeL ........................................................................ 4
coNNectING the Io FW810S ............................................. 5
Microphones ..................................................................................................5
Line Level Sources ..........................................................................................5
Instruments ....................................................................................................5
Computer/Digital Audio Workstation (DAW) ...............................................5
Headphones....................................................................................................5
Monitor Speakers............................................................................................5
Example Rear Panel Connections ...................................................................6
Example Rear Panel Connections ...................................................................6
the Io FW810S MIxeR - oveRvIeW .................................... 7
Installation......................................................................................................7
The Mixer – Input 1-8 Strips ........................................................................... 8
Monitor Reverbs .............................................................................................. 9
The Mixer - Balanced Out (Aux Out) Controls............................................... 10
The Mixer – Master Faders .............................................................................. 10
Channel Strip Dynamics ................................................................................. 11
Channel Strip Dynamics – Gate ...................................................................... 12
Channel Strip Dynamics – Compressor ........................................................... 12
Channel Strip Dynamics – Limiter .................................................................. 13
Channel Strip Dynamics – Gain Fader ............................................................ 14
EQ ................................................................................................................... 14
File Menu ......................................................................................................... 15
IO FW810S Control Panel .............................................................................. 16
SIGNAL FLoW dIAGRAM ..................................................... 17
SPecIFIcAtIoNS .................................................................. 19
tUtoRIAL - RecoRdING A GUItAR....................................... 21
exAMPLe PRoject - RecoRdING A GUItAR ......................... 23
Make Your Connections .................................................................................23
Connect the Guitar ................................................................................. 23
Connect the Headphones and/or Speakers.............................................. 24
Connect the Computer ........................................................................... 25
Install Drivers, Control Software, and Cubase® LE ........................................26
Set Up Windows® Audio and MIDI (Optional) .............................................. 26
The Software Mixer ........................................................................................27
Launch the Mixer Application ................................................................ 27
Set Levels ................................................................................................ 28
Add Monitor Reverb (Optional) ............................................................. 31
Set Up Cubase® LE for Use with the IO
FW810S (Windows®) .....................................................................................32
Set Up Cubase® LE for Use with the IO
FW810S (Mac®) .............................................................................................33
Record a Track in Cubase® LE ......................................................................... 34
Create a new project ............................................................................... 34
Start Recording ....................................................................................... 35
Listen to the Track You Just Recorded..................................................... 35
APPeNdIx ........................................................................... 37
Busses and Device Ports in Cubase® LE ........................................................... 37
Busses General Overview ........................................................................ 37
The Mixer ......................................................................................................37
Mixer General Overview ......................................................................... 37

Introduction
Congratulations and thank you for purchasing the Lexicon® IO FW810S!
With a wealth of features – including dbx® high-voltage, ultra low noise mic
pre’s, Pantheon II reverbs, and a powerful hardware mixing board with dbx
dynamics and hardware monitor reverb – the Lexicon IO FW810S is more
than just an 10-in, 12-out FireWireTM audio interface. It’s a pro recording
studio contained in a single rack unit.
Featuring newly designed dbx® 60V high-voltage, ultra-low noise microphone preamps on every channel, the IO FW810S is more than equipped
to provide professional recordings that keep your music sounding its best.
The preamps run on a 60V supply to guarantee stability and provide you
with a superior recording across a wide dynamic range. Performance driven
A/D - D/A converters ensure pristine 24bit/96kHz audio to capture every
subtle detail of your performance. And the newly updated Pantheon II plugin provides smooth, lush Lexicon reverbs for creating ideal sonic spaces.
With built-in dbx Type IVTM conversion, your digital recordings will preserve their dynamic range even when levels get too high. They’ll acquire that
forgiving, oversaturated quality once only found on big analog recorders.
Conversion actually gives you more headroom, capturing subtle details in
higher level signals instead of hard clipping them.
Plus, the Lexicon IO FW810S adds onboard dbx processing (compressor,
gate, limiter, and EQ) to the front end of your digital audio workstation
along with a powerful hardware Mixer. The Mixer’s true-to-life interface
design feels familiar from the second you start using it, making it easy to
adjust levels and route signals. The mixer allows you to save and load snapshots of mixer settings, and store your own power-on default snapshot; and
with it’s 12 outputs you can create up to five unique monitor mixes or mix
7.1 surround projects. When you apply the onboard dbx processing and
Lexicon monitoring reverb to your input signals, the IO FW810S does the
processing in real-time without taxing your CPU.
With so many powerful and useful recording studio tools, it’s more than just
a FireWire interface. It’s the Lexicon IO FW810S.

Features
•
•
•
•
•
•
•
•
•
•
•

8 dbx® high-voltage, ultra-low noise microphone preamps
2 front pannel input combi-jacks accept mic,line, or instrument signals
6 rear panel input combi-jack accept mic or line signals
8 analog TRS outputs (for sub-mixes) and 2 analog TRS L/R main
outputs
Stereo S/PDIF digital I/O
MIDI in and out
dbx compressor, limiter, gate, EQ, Type IV conversion processing
available on all 8 analog input channels
Lexicon monitor reverb; reverb sends available on all 18 software mixer
channels
Onboard signal processing occurs inside the FW810S, without taxing
your CPU
Fire Wire 400 (IEEE 1394) Audio Interface
44.1 to 96KHz sample rates, 24 bit conversion
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Unpacking the IO FW810S

The IO FW810S is shipped in one carton, containing the IO FW810S unit
and a software DVD for Windows® and Macintosh® systems. After unpacking, save all the packaging materials in case you ever have to ship the unit.
Thoroughly inspect the IO FW810S and packing materials for signs of
damage. Report any shipment damage to the carrier that delivered the product or dealer from whom you purchased the product at once.
the foLLowInG IteMS are IncLuDeD:

• IO FW810S
• Installer DVD containing FireWireTM drivers, this Owner's Manual,
Cubase LE Owner's manual, the FW810S Mixer software, the
Lexicon Pantheon II reverb plug-in, the XILS3 SE plug-in, Cubase LE
Recording Software, and ToonTrack EZ Drummer Lite for Mac® and
Windows®
• FireWire Connector Cable
• Lexicon Professional warranty registration

System Requirements

Powerful software for audio recording requires a powerful computer with
the right operating system software, processor and memory. Most computers currently sold already meet these requirements, or can be upgraded to be
compatible with the Lexicon IO FW810S. As with all such systems, adding
more RAM than the minimum will allow you to do more processing and
improve performance.
Windows Vista, XP, 7 (Minimum System Requirements)
®

•
•
•
•
•

Multicore processor
1GB RAM
Display Resolution 1024 x 768 pixels
DVD-ROM drive
Internet access required for software license activation

Mac (Minimum System Requirements)
®

•
•
•
•
•
•

Intel® Multicore processor
1 GB RAM
OS X Version 10.4.9 or higher
Display Resolution 1024 x 768 pixels
DVD-ROM drive
Internet access required for software license activation

Note: Adobe Reader is required to view the pdf documents on the DVD.
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front Panel

1

2

4

3

7

8

5 6

9 10 11

1. InPutS 1 anD 2 (MIc/InSt 1 anD MIc/InSt 2)

These balanced inputs accept XLR or 1/4” connectors, and support mic,
line, and instrument level sources (including guitars).
2. InStruMent Button/LeD

Press when an instrument level source (such as a guitar) is connected to the
corresponding input (1 or 2). The button illuminates when activated.
3. +48V Button/LeD

Each of these buttons enables the phantom power to the corresponding
inputs pairs. Dynamic microphones do not require phantom power to
operate. Most condenser microphones do require phantom power to operate. If you are unsure about the phantom power requirements for your
microphone, consult your microphone’s documentation or contact the
manufacturer. This switch should be OFF if you are connecting any linelevel source to the Mic/Inst or Mic Pre jacks.
4. DynaMIcS LeDS anD InPut LeVeL LeDS

The top three rows indicate what dynamics are active for each input. The
bottom three rows indicate signal presence (green) and level (yellow and
red) for each input.
5. fIrewIretM LeD

Indicates when a FireWireTM connection is present.
6. Power LeD

Indicates when the IO FW810S is turned on.
7. GaIn knoBS 1 anD 2

These knobs adjust the input gain levels for Mic/Inst 1 and Mic/Inst 2.
8. GaIn knoBS 3 – 8

These knobs adjust the input gain levels for Mic Pre 3 – 8 (the inputs
located on the back panel).
9. heaDPhone outPut Jack

Connect headphones here.
10. heaDPhone LeVeL knoB

Adjust headphone output signal level here.
11. MaIn outPutS LeVeL knoB

Adjust the main output signal level here.
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rear Panel

1 2

3 4 5 6

7

8

1. Power SwItch

Turn the IO FW810S on or off here.
2. Power Jack

Standard 3-pin IEC power connector. 100-240V, 50-60Hz automatic
switching to correct voltage range.
3. MIDI In anD out

The MIDI jacks provide MIDI input and MIDI output to and from your
computer. Connect your MIDI keyboards, sound modules, and external
controllers here.
4. S/PDIf In anD out

The S/PDIF in and out ports are unbalanced phono (RCA) connectors
that transmit and receive either a 16-bit or 24-bit two-channel audio
stream. S/PDIF ports may be found on many professional and consumer
CD and digital audio recorders. It is recommended to use 75-Ohm coaxial
cable for S/PDIF transfers and keep the cable length to a maximum of 10
meters to minimize interference and data dropout.
5. fIrewIretM PortS

Connect FireWireTM cables here. Either port can be used, with the other
acting as Thru.
Note: When daisy chaining devices, connect other IO FW810S units only.
Do not connect other FireWire devices to the IO FW810S.
6. BaLanceD outS 1–8

These outputs support balanced TRS or unbalanced TS ¼” connections.
These outputs can be connected to a mixing board, power amplifier, powered studio monitors, recorder, or another line level input.
7. MaIn outPutS

These outputs support balanced TRS or unbalanced TS ¼” connections.
These outputs can be connected to a mixing board, power amplifier, powered studio monitors, recorder, or another line level input.
8. MIc/LIne InPutS 3–8
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These balanced inputs accept XLR or 1/4” connectors, and support mic
and line level sources.

connecting the Io fw810S

For a step-by-step example project, refer to the Tutorial at the back of this
manual.

Microphones

Plug an XLR cable directly from a microphone into the desired Mic/Inst or
Mic Pre input on the FW810S front or rear panel. If you connect a microphone to a front panel input, make sure the Instrument button/LED above
the corresponding Gain knob is not lit. For example, if a microphone is connected to Mic/Inst 1, then the Instrument button/LED above the Gain 1
knob should not be lit.
If your microphone requires phantom power, first make sure the microphone
is connected, then press the +48V button/LED above that input pair's Gain
knob. If your mics don’t need phantom power, it is best to leave it off.
Note: Some microphones can be damaged by +48V phantom power.
Consult your microphone's documentation before enabling +48V phantom
power.

Line Level Sources

Line level sources include keyboards, drum machines, CD players, and external microphone preamps and effects. Plug a 1/4" TS (unbalanced) or TRS
(balanced) cable directly from the line level source into the desired Mic/Inst
or Mic Pre input on the FW810S front or real panel.
If you connect a line level source to a front panel input, make sure the
Instrument button/LED above the corresponding Gain knob is not lit.
For example, if a line level source is connected to Mic/Inst 1, then the
Instrument button/LED above the Gain 1 knob should not be lit.

Instruments

Front panel Mic/Inst jacks accept signals from instruments like electric
guitars and basses. Plug a standard ¼" TS (instrument) cable directly from
the instrument into one of the Mic/Inst input jacks on the front panel of
FW810S. Press the Instrument button/LED above the corresponding Gain
knob (Gain 1 for Mic/Inst 1, Gain 2 for Mic/Inst 2).

Computer/Digital Audio Workstation (DAW)

Connect your computer's FireWireTM port to the FireWire port on the IO
FW810S rear panel using a standard FireWire cable (included).

Headphones

Connect headphones to the Headphone jack located on the front panel. The
Headphone jack accepts an 1⁄4" TRS connector. Adjust headphone volume
with the Headphone Level knob.

Monitor Speakers

Using ¼" cables, connect the L/R Main Output jacks on the rear panel to
the appropriate inputs on your mixer, power amp, or powered monitors.
Adjust the output volume with the Output Level knob. Additional monitor
mixes may be created on outputs 1-8 using the integrated hardware digital
mixer.
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Example Front Panel Connections

Example Rear Panel Connections

FireWireTM Cable

6

the Io fw810S Mixer - overview

The IO FW810S includes a powerful hardware Mixer with a software control panel and built-in EQ, dynamics, and monitor reverbs. When open,
the Mixer controls the IO FW810S hardware. The controls are described in
more detail on the following pages, and a step-by-step example project can
be found in the Tutorial at the back of this manual.
To turn a knob in the mixer, click and hold on a knob and move the cursor
up to increase or down to decrease the parameter's value. To move a fader,
click and hold on the fader and move the cursor up or down to move the
fader up or down.
To return a knob to its default position, double click the knob. Ctrl-click to
fine adjust.

Installation

1. Insert the DVD into your DVD-ROM drive.
2. The Installer should start automatically. Follow the on-screen instructions to install the software you wish to use. The Mixer is included
with the Drivers and Control Software.
Note: You must install the IO FW810S Drivers and Control Software
to use the FW810S.

If the Installer doesn't start automatically, you can start it manually by opening the approprate file on the DVD:
For Mac:
For Windows:

Open Me
InstallationMenu.exe
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The Mixer – Input 1-8 Strips
Gain Reduction Meter/Button

Indicates the amount of gain reduction being applied. Click to open or close
the Dynamics Control Panel (described on page 13).
EQ Indicator/Button

Shows the EQ line for the corresponding channel. Click to open or close the
EQ (described on page 16).
Stereo button

Links two adjacent channels together in stereo. When linked, each strip’s
controls function as a pair; when you turn one strip’s Level knob, for example, the other strip’s Level knob automatically moves as well.
Pan

Positions the audio in the stereo field. The top four Pan knobs control their
corresponding Aux pairs. The bottom Pan knob controls the Main outs.
Level

Adjusts the loudness of the signal for stereo aux bus outs 1&2, 3&4, 5&6,
and 7&8.
Send

Sends the channel’s signal to the monitor reverb (described on page 11).
Mute button

Silences the signal in the main mix for the selected channel (the aux and
reverb levels are unaffected by this mute button).
Solo button

Silences all channels except this one. Note that multiple channels can be
"soloed" simultaneously.
Pre-Fader Input Level Meter

Indicates the signal level for this channel.
Fader

Attenuates or adds gain to the signal in the main mix.
Label (Scribble Strip)

Double-click to enter a name for the channel here.
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Monitor Reverbs
The Mixer includes monitor reverb feature (also known as a "courtesy"
reverb) which can be applied to and mixed in with signals passing through
the Mixer. The result can be heard through the Main outs as well as through
the Aux outs.
Power button

Turns the reverb effect on or off.
Type knob

Selects the desired reverb: Ambience, Chamber, SmallHall, LargeHall,
Room, SmallPlate, LargePlate, VocalHall, or VocalPlate.
Return knobs – Aux 1 through Aux 4

Adjusts the amount of reverb heard in the corresponding Aux out pair (when
the reverb is turned on). For example, the Aux 1 Return knob increases or
decreases the amount of reverb heard in Balanced Outs 1 and 2.
Parameters

These adjust various aspects of the reverb. Use the parameters to fine-tune
reverbs to meet your needs.
Pre-Delay

This is a delay that’s added to the diffused signal before it enters the
main part of the reverb. For all intents, it may be considered as delay
that is added to the reverberated signal. It is used to temporally separate
the reverb from the dry signal.
Mid-RT

MidRT is the mid frequency reverb time. As such, it is one of the primary controls affecting the length of the reverb tail. At low values, it
models a space with absorbent walls—a signal won’t bounce many times
before it dissipates. At high values, the walls are flat and extremely reflective. A signal lives a long time before dying away.
Size

Room Size corresponds roughly to the length of the longest wall of a
rectangular room. When the room size is small, the “walls” of this space
are closer together and the resultant reflection density increases. When
the room size is large, that density decreases.
High-Cut

This parameter is a low-pass filter in the recirculating part of the reverb.
It represents a frequency above which the tail dies away more quickly.
Main Outs

Adjusts the amount of reverb heard in the main outputs.
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The Mixer - Balanced Out (Aux Out) Controls
These controls correlate to Balanced Outs 1-8 (located on the back panel).
Outs 1-2 control Balanced Outs 1 and 2, Outs 3-4 control Balanced outs 3
and 4, and so on.
Labels (Scribble Strips)

Double-click to assign a name to an aux pair.
Level knobs

Adjusts the aux pair master signal level.
Meters

Indicate aux pair signal level.
Direct Outs buttons

Enable the DAW playback streams to go directly out the corresponding outputs. For example, when Direct Out is on for Outs 1-2, only playback 1-2
will be heard on Outs 1-2.

The Mixer – Master Faders
Meters

Indicate post-fader signal level.
Master faders

Attenuate or add gain to the main signal.
Stereo button

Links the two master faders together so their settings are always the same.
Main to S/PDIF button

Controls what signal is streamed out the SPDIF jack. When lit (on), the
main mix is mirrored on the SPDIF jack. When not lit (off ), the DAW
SPDIF Out stream is sent to the SPDIF jack.
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Channel Strip Dynamics

Inputs 1-8 in the Mixer feature Channel Strip Dynamics, including a gate,
compressor, limiter, and a gain fader. To open the Channel Strip Dynamics,
click the Gain Reduction meter/button at the top of the channel's "strip" in
the Mixer.
The gate, compresser, limiter, and gain fader are described in detail on the
following pages.
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Channel Strip Dynamics – Gate
On/Off button

Turns the Gate on or off.
Threshold knob

Sets the Threshold level. If there is any signal above the Threshold, the
Gate is Open, while a signal that is lower than the Threshold is attenuated.
Beware of setting the Threshold too high as it can cut off the tail end of
signals as they fade out (the sustain of a guitar note, a held piano chord, a
reverb tail, etc.). The Threshold is adjustable between –60 and 18 dB.
Attack knob

The Attack parameter sets the speed at which the Gate opens once the
Threshold has been crossed. It is recommended that very fast attack times be
used to catch the fronts of transient signals. The Attack parameter is adjustable between 0.1 to 200 mSec.
Release knob

The Release sets the rate at which the gate “closes” or attenuates once the
end of the Hold time is reached. Release can be adjusted between 350 and 5
dB/Sec.
Ratio knob

This control determines how much the signal will be attenuated once it
drops below the Threshold. This ratio works opposite from that of the compressor or limiter. If a Ratio of 1:4 is selected, a signal that is 1dB below the
threshold will be reduced in gain so that it becomes 4dB below the threshold. The Ratio is adjustable between 1:1 and 1:100.

Channel Strip Dynamics – Compressor
On/Off button

Turns the Compressor on or off.
Ratio knob

The Ratio is the rate at which the signal is reduced once the threshold is
crossed. A 2:1 ratio means that if the incoming signal is 2dB over the threshold, the unit will compress the signal, and output a signal that only goes 1dB
over the threshold. Setting the Ratio at Inf:1 makes the compressor act as a
limiter. The range of the Ratio parameter is from 1:1 to 100:1.
Over Easy knob

OverEasy is a characteristic of dbx® Compressors and is essentially a “softknee” function that occurs at about the compression threshold. On analog
dbx Compressors, OverEasy could only be turned on or off, but in the digital domain this parameter can have a range. This parameter can be adjusted
between 0 and 10 where 0 corresponds to no OverEasy, and 10 corresponds
to a very wide soft-knee region. To match the response of the classic dbx
160, an OverEasy of 6 is recommended.
Threshold knob
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The Threshold is the signal level at which the unit begins to compress the
signal. If the level is set to -10 dBFS, then any signal larger than -10 dBFS
is compressed, and any signal that has a level that is lower than -10dBFS is

not. For most signals the most natural sound is achieved when most of the
signal content remains just below the Threshold and only the peaks cross the
Threshold. The range of the Threshold fader is -60 to +18dBFS.
Auto button

Auto mode dynamically sets the Attack, Hold, and Release parameters in real
time, based on the incoming signal. This switch turns the Auto mode on and
off.
Attack knob

The Attack parameter sets how quickly the compressor starts to compress the
signal after it passes the threshold. The Attack can range between 0.1 mSec
to 200 mSec. The Attack time is dynamically set while in Auto mode.
Release knob

The Release parameter is the rate at which the Compressor comes out of
compression once the signal is back below the threshold and the Hold time
has elapsed. Release is measured in dB per second. For example, if Release is
set to 5 dB/Sec, and the signal has 10dB of gain reduction, the release time
is 2 Seconds. The Release range is from 350 dB/Sec to 5 dB/Sec. The Release
rate is dynamically set while in Auto mode.
Hold knob

The Hold parameter is the time the IO FW810S remains in compression
after the signal has dropped back below the threshold. Hold is adjustable
between 0 to 500 mSec and is dynamically set while in Auto mode.

Channel Strip Dynamics – Limiter
On/Off button

Turns the Limiter on or off.
Threshold knob

The Threshold is the signal level at which the unit begins to limit the signal. If the level is set to -10 dBFS, then any signal larger than -10 dBFS is
reduced in gain. The range of the Threshold fader is -60 to +18dBFS.
Auto button

This button turns Auto mode for the Limiter on and off. Auto mode
dynamically sets the Limiter Attack and Release based on the input signal.
Attack knob

The Attack parameter sets how quickly the Limiter starts to reduce the gain
of the signal after it passes the Threshold. The Attack can range between
0.1 mSec and 200 mSec. The Attack time is dynamically set while in Auto
mode.
Release knob

The Release parameter is the rate at which the Limiter comes out of gain
reduction once the signal is back below the threshold and the Hold time has
elapsed. Release is measured in dB per second. For example, if Release is set
to 5 dB/Sec, and the signal has 10dB of gain reduction, the release time is
2 Seconds. The Release range is from 350 dB/Sec to 5 dB/Sec. The Release
rate is dynamically set while in Auto mode.
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Hold knob

The Hold parameter is the time the IO FW810S continues to reduce gain
after the signal has dropped back below the threshold. Hold is adjustable
between 0 and 500 mSec and is dynamically set while in Auto mode.

Channel Strip Dynamics – Gain Fader
This boosts or cuts the signal’s gain level, and is adjustable between 20 and
–30 dB. This is a digital trim designed to be used to compensate for the gain
or reduction created by the Dynamics or EQ.
For example, if your compressor or limiter settings are reducing your signal level, you could increase the Gain fader to bring the level back up.
Conversely, if your EQ settings are pushing levels into clipping territory, you
could decrease the gain fader to lower the level.

EQ

Inputs 1-8 in the Mixer feature a parametric EQ where you can cut or boost
selected frequency bands. You can edit parameters with the control knobs
(described below), or you can click and drag the anchor points in the EQ's
display (shown above). To open or close the EQ for a specific channel, click
the EQ indicator/button just below the Gain Reduction meter/button for
that channel.
Note: To return to flat, set all knobs to 12 o’clock (double-click a knob to
return it to 12 o'clock).
Lo Shelf – top knob (–12 dB to 12 dB)

Sets the overall gain of the low shelf frequency.
Lo Shelf – bottom knob (40 Hz to 320 KHz)

Selects the frequency of the low shelf.
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Lo Mid – top knob (–12 dB to 12 dB)

Sets the overall gain of the low mid frequency.
Lo Mid – middle knob (160 Hz to 1280 Hz)

Selects the frequency of the low mid.
Lo Mid – bottom knob (.5 to 4.0)

Sets the "Q" or width of the band.
Hi Mid – top knob (–12 dB to 12 dB)

Sets the overall gain of the high mid frequency.
Hi Mid – middle knob (640 Hz to 5120 Hz)

Selects the frequency of the high mid.
Hi Mid – bottom knob (.5 to 4.0)

Sets the "Q" or width of the band.
Hi Shelf – top knob (–12 dB to 12 dB)

Sets the overall gain of the high shelf frequency.
Hi Shelf – bottom knob (2500 Hz to 20 KHz)

Selects the frequency of the high shelf.
On/Off button

Turns the EQ on or off.

File Menu
The File menu lets you save and load snapshots. Snapshots are files (with
the extension .mix) that contain settings for the Dynamics, EQ, Aux buses,
pans, reverb, and levels.
Open Snapshot

Opens a previously saved snapshot.
Save Snapshot

Saves the current settings as a snapshot. If the snapshot already has been
saved and named, this command will overwrite the existing snapshot.
Save Snapshot As

Saves the current settings as a snapshot and prompts you for a file name.
Load Power-On Defaults

Applies the stored power-on defaults (settings) to the IO FW810S unit.
Store Power-On Defaults

Saves the current snapshot settings and applies them to the IO FW810S unit
each time it is turned on. You can use this to make a custom snapshot, save
it as the default, and use the FW810S as a stand-alone digital mixer without
a computer.
Quit

Closes the Mixer.
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IO FW810S Control Panel
If you're using a Mac®, you can set the Sample Rate (44.1 kHz, 48kHz,
88.2kHz, or 96kHz) and the Sync Source (Internal or SPDIF) using the
Audio MIDI Setup application (located in Applications/Utilities) and your
DAW.

Control Panel - Windows
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In Windows®, you can adjust these settings via the Driver Control Panel,
accessed through the Start menu. In addition to the Sample Rate and Sync
Source parameters, the Driver Control Panel in Windows includes a Buffer
Size setting, which controls the size of audio buffers used to stream audio
between the FW810S and your computer. Larger settings give you additional
latency and stability. If you experience pops and clicks in the audio, try
larger buffer settings.
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Specifications
Microphone Inputs:
Input Impedance:
Phantom Power:
Maximum gain:
E.I.N. (at max gain):
Maximum Input Level:
Frequency Response:
THD+N:

Female XLR Pin 2 Hot
3kW balanced
+48 Volts
+55 dB
−127 dB @ 55dB gain typical (150W source)
−130 dB @ 55dB gain typical A-weighted (150W
source)
+8 dBu
+/−1.5 dB, 20Hz - 20kHz
<0.02%, 20Hz - 20kHz
<0.002%, 1kHz, -6 dBu

Line Inputs:
Input Impedance:
Maximum Input Level:
Frequency Response:
THD+N:

1/4" TRS balanced or unbalanced
20kW balanced, 13kW unbalanced
+22 dBu
+/−1.5 dB, 20Hz - 20kHz
<0.02%, 20Hz - 20kHz
<0.002%, 1kHz, +18 dBu

Instrument Input:
Input Impedance:
Maximum Input Level:
Frequency Response:
THD+N:

1/4" TS unbalanced
500kW
+10 dBu
+/−2.5 dB, 20Hz - 20kHz
<0.08%, 1kHz, +4 dBu

Line Outputs:
Level:
Impedance:

1/4" TRS balanced or unbalanced
+20 dBu maximum
32W Balanced, 16W Unbalanced

Headphone Output:

1/4" stereo jack 250mW per channel at 50W

MIDI Interface:
Sample Rate:

5 pin DIN connectors for MIDI in and MIDI out
44.1, 48, 88.2, or 96 kHz (determined by computer
application)

Dynamic Range:

A/D (24 Bit) 110 dB typical, A-weighted, 20Hz 20kHz
D/A (24 Bit) 110 dB typical, A-weighted, 20Hz 20kHz
A/D/A (24 Bit) 108 dB typical, A-weighted, 20Hz 20kHz

Power Requirements:
Dimensions:
Weight:

100 – 240 VAC, 50/60 Hz, 30 Watts
19”W x 1.7”H x 10.5”D
7.7 lbs.

Lexicon engineers are constantly working to improve the quality of our products. Specifications
are therefore subject to change without notice.
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FireWire
Audio Interface
with integrated channel strip processing

TUTORIAL – RECORDING A GUITAR

exaMPLe ProJect - recorDInG a GuItar

Welcome to the IO FW810S Tutorial. This tutorial shows you how to set
up the FW810S and Cubase® LE to record a single guitar track. Follow the
proceeding steps sequentially for best results. The FW810S works with many
DAW applications, however this tutorial is written for use with Cubase®
LE – the recording application which ships with the FW810S. Start with all
cables disconnected. Enjoy.

Make Your Connections
Connect the Guitar

1. Turn the Gain 1 knob all the way down.

Gain 1 Knob
2. Press the Instrument button, located over the Gain 1 knob, to the in
position.

Instrument
Button/LED

3. Connect your guitar to the Mic/Inst 1 input on the front panel.
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Connect the Headphones and/or Speakers

1. Turn the Headphone Level knob and Main Outputs Level knob all the
way down.

Main Outputs
Level Knob

Headphone
Level Knob

2. If using headphones, connect your headphones to the Headphone jack.

3. If using monitor speakers, plug the speaker's amplifier or powered
speakers into the Main Left and Right Outputs.
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Connect the Computer
1. Using the provided FireWireTM cable (or equivalent), connect the
FW810S to the computer's FireWireTM port.

2. Plug in the power cable and turn on the FW810S. The power switch is
located on the back panel.

Power Switch
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Install Drivers, Control Software, and Cubase® LE

1. Insert the DVD into your DVD-ROM drive. The Installer should start
automatically.
If the Installer doesn't start automatically, you can start it manually by
opening the approprate file on the DVD:
Mac®:
Windows®:

Open Me
InstallationMenu.exe

2. Once the Installer is open, follow the on-screen instructions to install
the software you wish to use.
Note: You must install the IO FW810S Drivers and Control Software
to use the FW810S. You must also install Cubase® LE to follow the
steps in this tutorial.
The latest drivers can also be downloaded from www.lexiconpro.com.

Set Up Windows® Audio and MIDI (Optional)

When the Drivers and Control Software were installed, Windows may have
automatically selected them as your default audio and MIDI outputs. This
means that your Windows sounds will be sent to the FW810S rather than
your computer’s sound card. If this is not desired, you can check if these
have been changed and return the settings to what they were before.
Windows® XP:
Select Start > Control Panel > Sounds and Audio Devices > Audio Tab.
Set the default recording and default playback device to your PC'S onboard
sound card and click apply.
Under MIDI Music Playback > Default Device, open the pull-down menu
and make sure Microsoft GS Wavetable Synth is selected as the default
device (XP only).
Windows® Vista/7
Select Start > Control Panel > Sounds. Set the playback and record device
to your PC’S onboard sound card, to do this, highlight the PC’S onboard
sound card and click use default.
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The Software Mixer
Launch the Mixer Application
1. Make sure the FW810S is turned on and connected to your computer
via FireWireTM. The blue FireWire LED lights when a valid FireWireTM
connection is present.
2. Open the Mixer:
Mac® OS: In the Applications folder, double-click IO FW810S Mixer.
Windows® OS: Go to Start > All Programs > Lexicon > IO FW810S >
FW810S Mixer.
3. In the Mixer, make sure the Master Faders are all the way down.

Master
Faders
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Set Levels

1. Make sure the Headphone Level knob and Main Outputs Level knob
are still turned all the way down on the front panel of the FW810S.
2. On the IO FW810S, turn up the Gain 1 knob to the 12 o'clock position.

Gain 1 Knob
3. In the Mixer, click the Stereo button at the top of the Mixer's Input
1 and Input 2 channel strips so it is in the "out" position (light gray
instead of dark gray).

Stereo
Button

4. Turn the Input 1 Pan knob (just above the Mute button) to the 12
o'clock position (C).

Input 1
Pan Knob
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5. Make sure the Input 1 fader is set to 0. If it is not, set it to 0.

Input 1
Fader

6. Play the guitar and note the meter in the Mixer's Input 1 strip; it should
be moving, indicating a signal is present. If the meter isn't indicating
a signal while you play the guitar, turn up the Gain 1 knob on the IO
FW810S until it does. Aim for a peak signal level which does not exceed
-6 dB on the meter when the guitar is strummed.

Input 1
Strip

7. Slide the Master Faders up to 0.

Master
Faders
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8. Put on the headphones. While playing the guitar, gradually turn up the
Headphone Level knob until you reach a comfortable listening level. If
you would rather monitor the signal through the monitor speakers, turn
on the powered speakers or amplifier. While playing the guitar, gradually
turn up the Main Outputs Level knob until you reach the desired
listening level. Do not to turn it up to the point of feedback.

Main Outputs
Level Knob

Headphone
Level Knob
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Add Monitor Reverb (Optional)
This will allow you to monitor the signal with reverb applied, but will not
actually record the reverb to the audio track.
1. In the Mixer, in the Input 1 strip, turn up the Send knob to 0.00 dB.

Send
Knob

2. In the Reverb section. click the Power button to turn on the reverb.

Reverb Power Button

3. While playing the guitar, turn up the Main Outs knob until the desired
amount of reverb is reached.

Main Outs
Knob
31

Set Up Cubase® LE for Use with the IO FW810S
(Windows®)

Make sure the included FireWireTM cable is connected between your
computer and FW810S, the Mixer is open, and the FW810S is turned on.
Start Cubase® LE (from the Start menu under Lexicon®).
If you see the warning shown below, click OK.

Once you are in Cubase LE, go to Devices > Device Setup.

Under Devices, click on VST Audio System and select ASIO Lexicon IO
from the ASIO Driver pull-down menu if it is not already selected. Click on
Switch to switch the driver, then click OK in the Device Setup dialog. You
are now ready to begin recording using your FW810S and Cubase LE.
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Set Up Cubase LE® for Use with the IO FW810S
(Mac®)

Make sure the included FireWireTM cable is connected between your
computer and FW810S, the Mixer is open, and the FW810S is turned on.
Open Cubase LE (located in the Applications folder), and go to Devices >
Device Setup as shown below.

Click VST Audio System, then select Lexicon IO as the ASIO Driver if it is
not already selected.

4. Cubase® LE will now ask you if you would like to switch the driver. Select
Switch then OK.

Mac® OS 10.4.x users only: After selecting Lexicon® FW810S as the ASIO
Driver, you may need to verify that your device inputs are active. To do this,
follow these steps:
1. Select Device > VST Connections from the menu bar.
2. When the VST Connections panel appears, click the Inputs tab.
3. The box under the Audio Device column may say “Not Connected”. If
it does, click in this box and select Lexicon IO to enable the FW810S
inputs.
4. Close the VST Connections window.
You are now ready to start recording with Cubase LE, described in the next
section, Using the IO FW810S.
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Record a Track in Cubase® LE
Create a new project

In Cubase, Click File > New Project. The New Project dialog opens.
Select Lexicon IO FW810S and click OK.
Select a project folder and click Choose.
Add a mono track by clicking Project > Add Track > Audio. Choose the
Mono configuration and click OK.
should already be
5. In the Track 1 window, the Record Enable button
red. If it isn't, click it so that it turns red.

1.
2.
3.
4.

6. In the Track 1 window, click the Input Monitoring button
is not lit.
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so that it

Start Recording

1. Click the Record button on Cubase® LE’s Transport control.

Record Button

2. Play the guitar.
3. When you are finished recording press the Stop button.

Stop Button

Listen to the Track You Just Recorded

1. In the Cubase® Mixer, make sure the Playback 1 fader is set to 0 dB.
Note: You may need to click and hold the scrollbar at the bottom of the
Mixer and slide it to the right in order to see the Playback 1 strip.
2. Press Rewind and press the Play button to listen to the track you have
just recorded.

Rewind and Play Buttons
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aPPenDIx
Busses and Device Ports in Cubase® LE

In Cubase® LE, and in most Digital Audio Workstations (DAW's), the
busses (the signal paths in and out of the DAW) can correspond to any of
the FW810S' physical inputs and outputs (referred to as device ports in
Cubase®). You can assign busses to device ports with the VST Connections
dialog in Cubase® LE (Devices > VST Connections). This process is
performed automatically when you create a new project using the Lexicon
IO FW810S template in Cubase® LE. Also, the following general overview
may be useful as well.

Busses General Overview
Assigning busses to device ports involves these steps:
1. In Cubase®, click Devices > VST Connections.
2. Create a bus in Cubase® (or use an existing one).
3. Select a channel within the bus (Left, Right, or Mono).
4. In the Device Port column, select a device port for the bus.
Let's say, for example, that you select the bus in Cubase® LE named Stereo
In - Left, and assign it to the device port named Lexicon IO 3. When you
create a project and add an audio track, and you want that track to record
vocals sung into a microphone (for example), you should connect the
microphone to the FW810S input named Mic/Line 3.
In Cubase® LE, you should set the track's input routing to Stereo In - Left.
Thus, the device port (physical connection on the FW810S) is assigned to the
bus (in Cubase® LE). The bus is now routed to the audio track, and the audio
going to the physical connection is recorded on the audio track.
The output busses work in basically the same way. Suppose you assign a
device port named Lexicon IO 5 to a bus named Stereo Out - Left, and you
route an audio track to that bus. The audio track's signal will be sent through
the Mixer (described below) to the FW810S' Main Outs, as well as to the
Balanced Out 5 on the FW810S rear panel.

The Mixer

In between the IO FW810S and your DAW is the IO FW810S' software
Mixer, a mixing console with a graphic user interface that functions like
a physical mixing console. The Mixer lets you adjust levels for individual
channels, apply reverbs, dynamics and EQ to aux sends and monitor mixes –
almost anything a physical mixer would allow you to do.
The Mixer's controls and components are described earlier in this Owner's
Manual. The following general overview may also be useful.

Mixer General Overview
The Mixer includes 8 Input channels (for the FW810S Mic/Inst and Mic/
Line inputs), 2 SPDIF channels (for the FW810S SPDIF In and Out), and
8 Playback channels (for signals coming from your DAW).
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